
l Suite
¡ New Splash
¡ WITec Control Help integrated in this Help

l True Match
¡ Automatically created search sets for each database
¡ New Search Option "Optimize HQI" to improve HQI calculation of noisy spectra
¡ New Search Option "Subtract 2nd Spectrum" to improve multi component search HQI 

calculation of mixed spectra (e.g. subtract big portion of substrate to see small portion of 
"interesting" material - HQI is otherwise dominated by substrate)

¡ Jump to next/previous material buttons if columns are sorted by material
¡ CSV Export can now be sorted by original list instead of using the display sort
¡ Save/Load Spectral Masks

l Particle Scout
¡ New Reporting Features (Exportable as bitmap into the clipboard)

n Map with Legend (Image with Particle Mask)
n Bar Chart with Legend
n Pie Chart with Legend
n Particle Thumbnails with Spectrum
n Table with styling possibilities

¡ New Specturm Measurement Options
n Signal optimization using automatic signal to noise ratio detector
n Auto focus and signal optimization masks can now be edited in the particle scout 

GUI (using some installed default spectra selectable from a list) 
¡ New "Watershed" Mask Algorithm to find particles
¡ Add particles to the current project

n Possibility to find and add particles from the same image to the current particle 
project (e.g. dark particles, then bright particles)

n Possibility to load multiple images and find and add particles to the current project
n Possibility to export multiple bitmaps from WITec Project into particle scout
n The first image is always the master image. Only the master image will be 

displayed and saved in the project.
n Possibility to define a material name for each exported bitmap

¡ Possibility to import a custom particle mask from file
¡ Improved performance and higher resolution of image and mask previews
¡ Improved performance for loading and saving
¡ Attach results from True Match new features

n For each search spectrum, the first flagged result is now used, if any is flagged
n Multi Component Search: User can select which component should be used
n Possibility to set minimum weight limit if a sub component is selected 

¡ Jump to next/previous material buttons if particle list is sorted by material
¡ Now supports big images
¡ Material can now be attached to a particle without having a spectrum
¡ Unified CSV Export brackets for units
¡ Save/Load Spectral Masks

l Video Window
¡ New Particle Scout Stitching Tab: Supports High-Resolution Images

Possibility to define stitching mask (circle, pie, cross)
¡ Video Image Vignetting Correction with automatic calibration
¡ Support for new automated Output-Multi-Coupler and automatic laser output adjustment 

using adjustment plates
¡ TSM3 User Interface now integrated in Video Window (shares place with AFM user 

interface)
¡ Speed Limit for Sample Positioner now available in options next to joystick
¡ Illumination / Brightness now also controllable via gamepad in auxiliary device modes 

l WITec Project

WITec Suite 5.3
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¡ New Look / Icons in Main Window
¡ Graph Viewer: Shortcut Control-C now only copies bitmap. Control-Shift-C copies ASCII 

Data
¡ True Component Analysis: User can now select which component spectra should be 

shown in the graph viewer
¡ Filter Viewer now shows new filters automatically

l WITec Control
¡ New Icons for Start Sequencer Buttons
¡ Spectral Auto Focus: now a mask can be defined instead of a single range
¡ KPFM now logs more values in text object
¡ Improvement of multiple styles and parameter names
¡ Automatic Software Z mode after successful signal stabilization

l New Software: WITec ParticleScout
¡ Find particles on (stitching-) video image
¡ Manage and filter particles
¡ ASCII / CSV Export of particles and spectra
¡ Measure Raman spectrum on all particles
¡ Calculate and attach spectrum properties to particle (Raman signal, Fluorescence signal, 

Oversaturation)
¡ Search in WITec TrueMatch spectral database and attach found material name + HQI to 

particle
¡ Simple statistical analysis (group by material and desired particle property, e.g. area) 
¡ Start via

n Video Image Stitching Dialog button
n Project Manager: Context menu of bitmap

l Microscope Control Application (Video Window)
¡ Support for new automated optics

n Field Stop and Aperture Stop
n Polarizer and Analyzer (Polarizer and Analyzer)
n Possibility for auto-link desired angle between polarizer and analyzer 

l WITec Control
¡ New data object names for new measurement data objects
¡ Spectrometer Calibration File is automatically selected

l WITec Project
¡ True Component Analysis

n Can now show and extract "only positive values" / positive weighting factors
n Can now extract Pearson correlation coefficient as an image (Plus version) 

¡ Spectrum Normalization now available in Graph Background Subtraction dialog
¡ Graph Viewer: Order of graph objects can be changed (e.g. for cascade display mode)
¡ Binary export of spectral data objects (raw 32 bit float format, much faster than ASCII)
¡ Graph and Image Viewer with all their settings can now be duplicated

l True Match
¡ Spectral mask is now a real mask (set and clear multiple ranges allowed)
¡ Search algorithm now corrects x-axis / wave-number shift (± 10 1/cm)
¡ The following sorting and grouping of result columns now available:

n No Sort
n Sort by Best HQI
n Sort and group by Best Material Name
n Sort by Best HQI and group by Material Name 

¡ Improved web search of sample properties
¡ HQI and PDF-Report available when comparing a search spectrum with a database 

spectrum in the database tab

WITec Suite 5.2
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l Image Viewer Features
¡ 3D Lighting effects (use shortcut "L")
¡ Animation Editor. Enables 3D Video Animations with full customizeable animation steps
¡ Better mouse handling (no cursor in 3D mode, 3D rotate / tilt with left mouse button)
¡ 3D panning via "Shift" + Middle Mouse Drag and "Shift" + Mouse Wheel. (Can also be 

used for animation "flight")
¡ Automatic Color Scale of last changed line now has separate button in status bar
¡ Background color can now be defined by user (also default options)
¡ Color Scale Export: precision of numbers now can be changed
¡ Separate buttons for exporting bitmap in original resolution
¡ New Button for Automatic 3D Scale with correct aspect ratio for topography images 

(Shortcut Ctrl-A) 
l Multi Bitmap Export

¡ Available Formats: Multiple Bitmap Files, Multi Frame TIFF, AVI Video
¡ Support for automatically opening a program after export
¡ Used in Image Stack Export, Image Overlay Morph, Image Viewer Animation 

l Image Stack Export Dialog
¡ Now with previews for X/Y, X/Z, Y/Z planes
¡ Automatic pixel interpolation in all directions
¡ Support for intensity correction in z direction
¡ Support for cutting planes, e.g. "opening" a cube for volume view now possible 

l Image Overlay Morph now exportable as AVI video
l Shape Background Subtraction: improved performance, noise threshold parameter was removed
l Image Combination Changes

¡ Supports automatic masks, thus avoiding over saturation
¡ Supports extracting all images with their color table, also with color scale bar (extract using 

viewer export settings) 
l True Component Analysis

¡ Supports Undo/Reset in Average tab
¡ Now calculates better initial residual image
¡ Multiple Auto Find now adds components without clearing existing components
¡ Demix parameters now stay untouched when adding / removing components 

l Graph Viewer Auto Zoom Enlarge Only (Status bar button)
l Drop Action Intensity Correction now available for removing Filter or Etaloning artifacts
l Main Menu removed "Add" menu. "Add Text" now available via project manager context menu
l Graph Viewer Peak Labelling now supports ignoring the Rayleigh area, configurable default 

options for line length, number of digits and better mouse handling
l Data Stitching now allows stitching of bitmap objects (works in combination with new Image 

Combination export option)
l Average Spectrum now supports dropping multiple single spectra objects
l Drop Action "Weighted Spectrum Subtraction" now integrated in Graph Background Subtraction 

Constant Tab, using a check box that enables the weighting factor mask
l "Reset Viewer Positions" now sets Project Dialog positions to screen center
l Improved performance when loading a WIP file with many data objects
l Improved performance when calculating image spectra datasets with memory extension / memory 

mapped file
l Progress Dialog now shows number of calculating cores instead of lots of sub-progress bars
l Project manager now always present (last one can not be closed)
l Load/Append Project now cleans unused objects in project

l Now supports using up to 4Gb of memory without memory extension (on 64bit Windows Operating 
Systems)

l New Analysis Dialog: True Component Analysis
¡ Replaces Basis Analysis Dialog
¡ Basis Spectra can be dropped, Dialog can be used like normal basis analysis
¡ Plus Version Features:

WITec Project 5.1
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n Add basis spectra (manually, automatically)
n Average spectra (using manual mask, threshold mask, automatic mask)
n Demix spectra (manually using wheel controls or edits) 

l New Dialog "Wizards" (Next Step buttons) and Raman Start Analysis button
l Software News / Did you know upon first program start
l Graph Viewer Features

¡ Mouse wheel can zoom all spectra in cascade mode
¡ Scale Edit Boxes for X-Axis also displayed in Graph List
¡ Possibility to create and manipulate masks without any dialog
¡ Configurable visibility of coordinate axes and ticks
¡ Rayleigh area is automatically removed from masks (range configurable in Graph Viewer 

Options) 
l Image Viewer Features

¡ Equalize color scale (non linear assignment of colors for displaying the maximal contrast 
for all dynamics)

¡ Controls for Contrast and Brightness (changes top and bottom color value automatically)
¡ Contrast and Brightness can now be adjusted in color bitmaps
¡ Draw Field / Mask: Erode and Dilate, "Minimum Structure Size" for threshold auto mask
¡ Smoother display of pixels if only few pixels are displayed
¡ Configurable visibility of coordinate axes and ticks
¡ Improved bitmap export (wysiwyg in 3D mode) 

l New colors in graph viewer and image combination dialog (now colors should fit to each other)
l Sum images from Filter Viewer or RamanTV now have spectral range in meta data. Press "G" in 

image viewer to show spectral range.
l Graph Background Subtraction: possibility to show the background subtracted spectrum as 

preview
l Average Spectra: possibility to do an average of multiple single spectra
l Peak Find: Edit peaks with mouse, show if peak finds are displayed (even if dialog is closed, e.g. 

after load project)
l Time for show geometry is now configurable
l Image Combination: Auto scale button
l Cluster Analysis Dialog: New Extract buttons, simpler user interface
l Possibility to display "um" instead of "µm" (for asian operating systems that can't display "µ", see 

Display Options)
l Image Calculator: works with images from different measurements
l Table export: header can be exported 

l Graph Viewer: Zoom out Rayleigh Peak (Shortcut "R", e.g. for calibration purposes)
l Show Scan Position / Geometry

¡ Press "G" in Graph or Image Viewer to show the Geometry/Scan Position of the displayed 
measurement 

l Larger Font Size in most windows of WITec Project and WITec Control
l Create Stack Slice / Depth Image from many stack images (drop onto Cross Section Dialog !)
l Graph Viewer fast zoom-in:

¡ With control-key hold down "draw" region
¡ Press space to zoom into peak at mouse position
¡ Zoom out x also zooms out y-axis, if auto y axis zoom is turned on 

l Project Manager Multiple Rename Tool: Possibility to replace only those objects that contain a 
search string

l Graph Viewer can create Mask without any Drop Action Dialog ( Circle Menu "Misc Visuals" -> 
Create Mask or Control-M )

l Advanced Fitting Tool: New result table for single spectra batch processing
l Shape Background Subtraction: Mask can now be used to do a simple line interpolation 
l Graph Viewer Peak Labels 

¡ Now all graphs in viewer are labelled 
¡ Peaks can be added/removed manually (note: change graph / space position does not 

work if peaks were manually added/removed !) 
¡ All Peaks and Display Settings are now saved for each graph viewer in the WIP File 

l Graph Viewer: "Export view as bitmap to project" now available in Export Menu 
l Show Scan Position / Geometry 

WITec Project 4.1
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¡ Press "G" in Graph or Image Viewer to show the Geometry/Scan Position of the displayed 
measurement 

l ASCII Data Export: File Suffix can be changed

l Look and Feel 
¡ New Splash/About Window 
¡ New Application Shortcut Icons on Desktop and Start Menu, new WIP File Icons 
¡ New Shortcut Viewer: Shows all the Shortcuts of the Software, see Menu Help -> Show 

Shortcuts 
¡ New Drop Action Icons 
¡ User is now notified if an action needs too much memory (some Drop Actions creating 

large graph objects, Copy/Paste of data objects in project manager) 
¡ Main Window: 

n New Tool Button for "Close All Viewers and Managers" next to "Reset Viewer 
Positions" Button 

n Recent WIP Files directly accessable in File Menu (no sub menu), better Structure 
of Menus 

¡ New Icon for Mask Image Objects (Extracted Draw Field Image or extracted calculator 
image with boolean unit name) 

¡ Automatic load of correct window settings (works for 1 monitor) 
l New Program Options Window (Menu Options -> Program Options) 

¡ Replaces Viewer Positioning options, Export options and adds some additional, new 
options 

¡ OpenGL Graphic Acceleration can be turned on or off in this new Program Options (has 
effect on WITec Project AND WITec Control of the same version) 

l Memory Extension 
¡ New Memory Option "Memory Mapped File" that allows the program to work with more 

than 2GB of data objects (e.g. for large Raman images or stacks; see Menu Options -> 
Memory Options) 

¡ 64-Bit Operating System with >=16GB of Memory as well as a Fast SSD Hard Drive as 
Memory Mapped File Location is recommended

l Cursor Manager: 
¡ The Cursor Manager is no longer a Viewer, but a Tool Window whose visibility can be 

toggled 
¡ The Cursor Manager Window is not visible by default due to new status information in 

viewers (see below) 
¡ The Cursor Manager Window can temporarily be shown via the Shortcut "P" in all Viewers 

l Drop Action Window: 
¡ The Drop Action Plus Window is no longer present. All Plus Drop Actions are shown in the 

standard Drop Action Window (if Plus is activated) 
¡ The Drop Action Window will automatically show up near the mouse position upon starting 

a drag Action in the Project Manager 
¡ Inclusion Area Button is no longer present. Each Dialog supporting a Mask now shows an 

Image Viewer. A mask can be drawn there or a previously defined mask can be assigned 
(dropped) 

l Viewers General 
¡ Automatic Mouse Mode 

n Graph Viewers with Masks automatically have the mark region mouse mode 
n If Listen is turned on, Graph and Image Viewers automatically select the correct 

mouse mode and switch back to move mode when listen is turned off. 
¡ Viewer Positioning Changes 

n If the last viewer of a viewer kind (e.g. Image Viewers) is closed, the positioning 
for this viewer kind will be reset 

n All Viewers are automatically repositioned after loading a project. There is an 
option to turn this feature on/off in the Viewer Positioning Options 

n Automatic Array: if there is not enough space for a new graph or image viewer, the 
size is automatically adjusted 

¡ New Status Bar in Graph/Image/Video Control Windows 
n The Status Bar now also shows a second line with more information (Graph 

Viewer: X Cursor Position, Image Viewer and Video Control: Space Cursor 

WITec Project 4.0
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Distance) 
n If cursor is listening, the label in the status bar is shown red. A click on the red 

label will turn off listen mode for this cursor 
n Some frequently used features can be found in the new status bar (e.g. Image 

Automatic Color Scale, Graph Zoom Functions) 
¡ Cross Hair has now red color when someone listens to one of the axes of a viewer 
¡ Extraction of currently shown data now works in all Graph/Image Viewers and it works 

always (also in Drop Action Previews and e.g. Hardware Spectrum Viewer). Shortcut 
"Control + E" 

¡ Text Viewer: Text objects can be toggled in the same viewer (via arrow buttons or 
shortcuts F5/F6) 

l New Filter Viewer (will replace old Filter Manager, also in WITec Control) 
¡ Filters are no longer project data objects 
¡ Filters are stored with the Viewer 
¡ Possibility to store a set of filters into a file for quick access (selectable for the current user 

or for all users) 
¡ Filter Range is defined by Position and Width 
¡ Filter Position/Width can be listened: Move Mouse Mode will change the Position, Mark 

Region Mouse Mode will change Position and Width 
¡ Preview Graph Window 

n Shows local average graph (like Spectrum to Images) and highlighted filter 
positions 

n Highlighted filter positions can be moved directly with the mouse move mode
n Mark Region Tool opens popup that can create or change new filters at marked 

range 
¡ Single Graphs have single-value-preview in status bar 
¡ Also works with Line Graphs and Graphs that have a spatial X-Transformation (Cross 

Section) 
¡ Input Graph can be changed (only if it has the same size and X-Transformation Unit kind) 

n Drop another Graph onto Title Bar 
n Use the Previous/Next Buttons in the Status Bar 
n Press Page Up / Page Down in an Filter Result Image Preview Window 

¡ Filter Preview can be toggled by selecting a filter. Checkboxes in Filter List allow to show 
more than 1 filter simultaneously. If no preview is opened, a double-click on filter will open 
a preview. 

¡ Batch Calculation via Drag & Drop onto Extract Buttons (Dropping onto "All" Button will 
calculate and extract all filters in the list) 

¡ New Data Objects are only created upon pressing one of the Extract Actions 
l Graph Viewer 

¡ New Zoom Modes 
n Automatic Y-Axis Zoom, Cascade and Synchronized Zoom is turned on by default 

(you can change the defaults in the Graph Viewer Program Options) 
n Improved Cascade function with new cascade distance parameter 
n Synchronized Zoom for zooming all graph objects without using the same Y-Axis 

¡ New Feature: Peak Labels can be shown (using peak find algorithm). Shortcut "F" 
¡ Graph Mask Data Object can now be dropped directly on a Mask in a Graph Viewer to set 

the Mask 
¡ Graph Mask can be hidden. Shortcut "H" 
¡ New Follow Data Mode: The Cursor will follow the exact supporting points of the currently 

shown graph 
¡ New Histogram Drawing avoids gaps and aliasing drawing problems (only if the X-

Transformation has equidistant points); supports cascade now 
¡ New Shortcut: Page Up / Page Down toggles through the Graph Objects in the project, if 

only 1 Graph is displayed 
¡ Graph Drawing Options can now be synchronized (e.g. set width for all graph objects in 

the same viewer) 
¡ Default Graph Drawing Width can be defined in the new Graph Viewer Program Options 

l Image Viewer 
¡ Image Viewer also shows Bitmaps. Bitmap Viewer is no longer needed 
¡ Image Viewer can show Bitmaps and Images that don't have a Space Transformation 
¡ New Feature: Synchronized Zoom. Will zoom all image viewers to the same spatial 

bounding box. Zoom Out in Synchronize Mode will zoom out all viewers. Shortcut "S" 
¡ Revised New Display Modes: 

n 3 Slots for Input Images: Color Image, 3D-Z Image, Brightness Image; all 
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assignable via drag drop 
n 3D Mode (toggle, Shortcut "3"), Brightness Mode (toggle) 
n 3D Image Mode now automatically uses perspective projection and side view 
n Free Camera Mode (toggle, automatically used in 3D Mode): Image can be tilted 

and rotated by moving the mouse while holding down the middle mouse button 
(wheel), Free Camera Distance can be defined using the Mousewheel 

¡ Crosshair can be hidden (e.g. for nice presentations) 
¡ Draw Field / Mask can be hidden. Shortcut "H" 
¡ Draw Field: Pen Width for Draw Point mode can be changed 
¡ Image can be animated (change the animation speed in Image Viewer Program Options) 
¡ Contour Lines can be drawn (Misc Visuals Circle Menu) 
¡ Nice Mesh Borders will close the borders in 3D Mode (Visuals Circle Menu) 
¡ Line Correction can be changed in the right bottom corner in the new statusbar 
¡ Automatic Color Scale (and toggle with rightclick) can be found in the right bottom corner 

in the new statusbar 
¡ Color Scale: 

n Bottom/Top Color Scale can now be swapped 
n Bottom/Top Color scale can now be changed synchronously 
n In the new Image Viewer Program Options the behavior of the automatic color 

scale algorithm can be adjusted 
¡ Scalebar now has transparent background 
¡ Dropping multiple objects on the viewer for showing the positions in one step is now 

possible 
l Image and Graph Tools 

¡ Tool Windows are no longer present 
¡ New Circle Menus in Image and Graph Viewer: 

n Hold right mouse button down to see circle menu and then select one of the circle 
menus by moving the mouse in the right direction 

¡ All features can be found in the new circle menus, also those who previously only could be 
found in the normal context menu

¡ Start Drop Action Dialogs directly from an image/graph viewer circle menu 
l Project Manager 

¡ New Circle Menu for toggling visibility and sort of objects and for starting drop action data 
analysis 

¡ Only Graph, Image/Bitmap, Text Objects are shown (Advanced Mode shows all objects) 
¡ New Multiple Rename Tool with rename mask and search and replace functionality 

integrated 
¡ Project Managers now highlight all data objects that are used by another viewer when this 

viewer is activated/selected. There is an option to turn this feature on/off in the Viewer 
Positioning Options 

¡ Project Managers are not loaded when appending a project. There is an option to turn this 
feature on/off in the Viewer Positioning Options 

l Drop Action Dialogs: 
¡ New Dialog "Image Histogram and Statistics": Image Histogram Dialog now also shows 

Image Statistics and Roughness parameters 
¡ New Dialog "Image Transform and Overlay" (Plus Feature): allows to change the spatial 

transformation of images and creates overlay bitmaps, supporting advanced 
transformations 

¡ New Dialog "Graph Repair" (Plus Feature): allows to interpolate manually selected 
spectral pixels or ranges for certain or all spectra in any kind of graph data object 

¡ New Dialog "Graph and Image Data Stitching" (Plus Feature): allows to stitch/merge a 
stack of images or graph images into one new bigger data object 

¡ New Dialog "Image Correlation" (Plus Feature): shows correlation points according to 
changeable mask in image viewer 

¡ New Cluster Analysis User Interface: only one window, simplified handling 
¡ Revised Background Subtraction Dialog 

n New Subtraction Mode "Minimum". Subtracts the minimum of all spectral pixels 
(using the mask) 

n New Subtraction Mode "Constant". A constant value or a constant spectrum can 
be subtracted 

n New Subtraction Mode "Shape" (Plus Feature). A rounded shape is fitted on the 
spectrum, leading to a excellent background subtraction, even for fluorescence 
offsets 

n Now supports cross section graph objects 
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¡ Image Cross Section Dialog: Simplified Dialog, Start/Stop Coordinates can now be 
swapped 

¡ Image Color Combination: 
n Redesign with Simple/Advanced Mode 
n New mode "Allow Color Mixing" 
n Listenable Edits, Color-Scale-Synchronization with Image Viewer, wheels for 

changing the color scale 
n Improved transparency smooth parameter 

¡ Spectrum to Images: Improved Listen mode 
¡ Graph Basis Analysis: Simplified Dialog 
¡ Advanced Fitting Tool: Simplified Dialog 
¡ Image Filter Dialogs no longer show error images, but have a new checkbox for showing 

the original image temporarily (Image Filter, Image FFT 2D, Image Background 
Subtraction) 

¡ Data Binning Dialog is now called Data Cropping and Reduction. Simplified Dialog; now 
allows to crop bitmaps too 

n New in Version 4.0.12.9: Batch mode via Drag & Drop
¡ Graph Demixer now allows to use the current mix as new source graphs; allows graphs 

with different x transformations objects that are equal 
¡ Only one Calculator Dialog for Images and/or Graph Objects 
¡ Image Filter Dialog: new image smoothing algorithm: "Anisotropic Smoothing" 

l Similar Drop Actions are now merged into one Dialog 
¡ Image Statistics/Roughness Drop Actions are merged into the new "Histogram and 

Statistics" Dialog (Image Histogram, Image Statistics, Image Roughness) 
¡ Graph Filter Dialogs are merged into one dialog (Graph Average, Graph Median, Graph 

Savitzky Golay, Graph CRR) 
¡ Image Filter Dialogs are merged into one dialog (Image Median, Image Average, Plus 

Version Image Filters like Sobel, ...) 
¡ Image Background Subtraction Dialogs are merged into one dialog (N-Order Line 

Subtraction, N-Order Surface Subtraction) 
¡ Image Stack Dialogs are merged into one Dialog (Image Auto Focus, Image Extended 

Focus) 
¡ Image FFT Filters are merged into one Dialog (Image FFT Amplitude, Image Filter FFT 

Line, Image FFT 2D) 
¡ Image Line Interpolation and Image Remove Bad Data Dialoges are merged into one 

dialog 
l Import/Export 

¡ New Bitmap Import: Bitmaps can be imported via Menu File -> Import -> Bitmap or use 
Paste in Project Manager (Strg-V) if Bitmap is in clipboard 

¡ Tescan TIF Import (for SEM images, needs special license) 
¡ Export to Matlab 
¡ Batch Export for Text Objects (ASCII and RTF) 

l New Drop Action: Inverse Basis Analysis (the right button next to the Basis Analysis Button): 
¡ Uses an image graph together with Images (which should be background subtracted) that 

belong to the image graph 
¡ Calculates offset and de-mixed component spectra for each image 

l Image and Bitmap Viewer: Drag and Drop of Graph and Image Objects onto the Viewers now open 
a Popup Menu for selecting several actions: 

¡ Show Position (Transformation) -> It's no longer necessary to search for the 
transformation of an image graph or image or bitmap to show it in a viewer 

¡ Use as Main Image/Bitmap 
¡ Use as second Brightness/Color Image (Image or Bitmap on Image Viewer only) 
¡ Use Bitmap as Texture (Bitmap on Image Viewer Only) 
¡ Use as Draw field (Image on Image Viewer Only) 

l Drop Action Advanced Fitting Tool: 
¡ Batch calculation now available through Drag Drop onto the "Extract All" Button 
¡ Now some additional information for the current fit is shown (coefficient of determination, 

reduced chi square, average error) 
¡ Replica of multi peak functions can now be shown and extracted (Gauss, Lorentz) 

WITec Project 2.10
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¡ Fit curves of all pixels can now be calculated and extracted 
¡ Text Result (single fit extraction) now shows more information 
¡ Works now with Cross Section Graph Objects (3 Dimensional X-Transformations) 

l Spectrum To Image: 
¡ Drop Action as well as Online Algorithm now support different Filters for calculating image 

values: Sum, Variance, Average Binomial, Average Box, Average minus Minimum 
¡ Drop Action now works with 1-Dimensional Graph Objects (Time Series, Cross Section 

Graph, ...) 
l Auto Scale on Data Change Function in Graph- and Image Viewers 

¡ It's now possible to right-click on the image tool window button "Automatic Color Scale" (or 
on the graph tool window buttons for zooming out) in order to turn on/off the automatic 
scaling if the data changes 

¡ Additional Option in Graph Viewer Popup Menu: "Auto Cascade" 
l Drop Action Image Cross Section: It's now possible to define a horizontal or vertical line that uses 

the exact pixel supporting points as cross section values 
l Graph Viewer Data Export (e.g. to ACDLABS / UV/IR-Manager): the user can now define the 

program path in "Menu -> Options -> Export -> Graph ASCII to External Program" instead of 
editing a text file 

l New Bitmap Export: It's now possible to export a couple of bitmap data objects at once into jpg, 
png, and bmp files. (Project Manager "Popup Menu -> Export")

l ASCII Export of Graph/Image/Bitmap Data is now available through Project Manager "Popup 
Menu -> Export" and offers some export options 

l New in Version 2.10.3: SPC Export now also works with Image Spectrum Data (2D) 

Page 9 of 9WITec Suite 5.3

1/12/2023file:///C:/Users/Witec/AppData/Local/Temp/~hhF556.htm


